
Fabien Vultier Februar 2015 

Blender Tutorial für Orxonox 

Einleitung 
In diesem Tutorial lernst du zuerst wie du das Programm „Blender“ installierst und richtig 

konfigurierst. Danach wird Schritt für Schritt erklärt, wie du ein Raumschiff für Orxonox modellierst 

und texturierst. Schlussendlich exportieren wir das Modell und importieren es ins Spiel. 

Viel Spass! 

1.1 
Lade Blender 2.69 herunter (https://download.blender.org/release/Blender2.69) und installiere das 

Programm 

 Für dieses Tutorial musst du genau diese Version installieren. Andere Versionen haben andere 

Menus und sind eventuell nicht mit dem OGRE Exporter kompatibel. 

Wenn du eine neuere Version von Blender verwendest, kann es vorkommen, dass einige Funktionen 

in anderen Menus sind als in diesem Tutorial beschrieben. 

1.2 
Lade Blender2Ogre 0.6.0 herunter (https://code.google.com/p/blender2ogre/downloads/list). Das 

Zip-Archiv musst du nicht extrahieren. 

1.3 
Starte Blender und öffne das Menu File → User Preferences. 

1.4 
Klick zuerst auf Addons und dann auf Install from file … 

https://download.blender.org/release/Blender2.69
https://code.google.com/p/blender2ogre/downloads/list
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1.5 
Wähle die Datei blender2ogre-0.6.0.zip aus und klick auf Install from file.  

 

1.6 
Das Addon blender2ogre ist Blender ab jetzt bekannt. Um es zu verwenden muss es noch aktiviert 

werden. Gib dazu oben links bei der Suchfunktion  „ogre“ ein und markiere das Addon mit einem 

Haken.  
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1.7 
Klick auf Save User Settings und schliesse das Menu. 

 

1.8 
Wenn das Addon richtig installiert wurde, sollte unter File → Export der Menupunkt Ogre3D (.scene 

and .mesh) sichtbar sein. 
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Nun kann es losgehen mit dem Modellieren! 

2.1 
Standardmässig platziert Blender beim Start einen Würfel im Ursprung des Koordinatensystems. Aus 

diesem Würfel werden wir nun ein einfaches Raumschiff für Orxonox modellieren. 

 

Für ein Raumschiff und viele andere Objekte ist ein Würfel ein geeigneter Ausgangspunkt. Für stark 

rotationssymmetrische Objekte wie zum Beispiel eine Rakete oder ein Teller könnte aber ein Zylinder 

oder eine Kugel besser geeignet sein. Für dieses Tutorial begnügen wir uns mit dem Standardwürfel. 

Mach dich zuerst mit der Ansicht vertraut. 

- Halte die mittlere Maustaste gedrückt und bewege die Maus um die Ansicht zu drehen. 

- Drehe das Mausrad um zu zoomen 

- Du kannst auch die CTRL-Taste und die mittlere Maustaste gedrückt und dabei die Maus 

bewegen um zu zoomen. 

- Wenn die SHIFT-Taste gedrückt ist während du die mittlere Maustaste drückst und die Maus 

verschiebst kannst du die Ansicht verschieben. 

2.2 
Beim Start von Blender wird nicht nur der Würfel automatisch platziert. Blender erzeugt auch eine 

Lampe und eine Kamera. Diese drei Objekte sind rechts in der Liste ersichtlich. 
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- Du kannst z.B. die Kamera selektieren, indem du mit der rechten Maustaste darauf klickst. 

- Du kannst ein neues Objekt zur Auswahl hinzufügen indem du während dem Rechtsklick die 

SHIFT-Tast gedrückt hältst. Wähle die Kamera und den Würfel aus. 

- Objekte können auch selektiert werden, indem sie rechts oben in der Liste mit einem 

Linksklick ausgewählt werden. 

2.3 
Bis jetzt befanden wir uns im sogenannten Object Mode von Blender. Darin können wir Objekte wie 

Würfel, Zylinder, Kameras und Lampen verschieben, hinzufügen oder löschen. Diese Objekte können 

aber im Object Mode nicht bearbeitet werden. Dazu müssen wir in den Edit Mode des Würfels 

wechseln. 

- Selektiere dazu den Würfel mit der rechten Maustaste aus und schalte dann links unten in 

den Edit Mode des Würfels um. 

- Alternativ kannst du auch die TAB-Taste drücken. Dies funktioniert allerdings nur wenn sich 

die Maus im Arbeitsbereich in der Mitte befindet, also z.B. nicht auf einem Menu.  

Shortcuts sind in Blender immer abhängig von der Position des Mauszeigers. Die meisten 

funktionieren nur, wenn sich der Mauszeiger im Arbeitsbereich und nicht über einem Menu befindet. 
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2.4 
Drücke nun einmal die A-Taste während sich die Maus im Arbeitsbereich befindet. Du erkennst, dass 

der ganze Würfel, d.h. alle Ecken, Kanten und Flächen ausgewählt werden. Durch wiederholtes 

drücken wird wieder alles deselektiert. 

Unser Raumschiff soll eine längliche Form haben. Dazu skalieren wir den Würfel in x-Richtung. 

- Wähle wie oben beschrieben den ganzen Würfel an. 

- Drücke dann die S-Taste um zu skalieren. Durch bewegen der Maus wir die Grösse des 

Würfels in alle 3 Raumrichtungen skaliert. 

- Um die Skalierung in die x-Richtung einzuschränken musst du die X-Taste drücken. 

- Zieh mit der Maus den Würfel in die Länge und klick zur Bestätigung. 

- Drücke CTRL+Z um die Skalierung rückgängig zu machen 

- Als Alternative zum Skalieren mit der Maus empfiehlt es sich über die Tastatur einen 

Skalierungsfaktor einzugeben und mit RETURN zu bestätigen. Gib über die Tastatur ein: S X 3 

ENTER. Der Würfel wir nun in x-Richtung genau um den Faktor 3 skaliert. 

 

2.5 
Durch drücken von CTRL und Z während sich die Maus im Arbeitsbereich befindet kannst du jederzeit 

eine Aktionen rückgängig machen. 

2.6 
Jetzt wollen wir den Quader in Y-Richtung verschieben. Das Vorgehen ist ähnlich wie beim Skalieren. 

- Vergewissere dich, dass der ganze Quader immer noch selektiert ist. 

- Drücke die G-Taste während sich der Mauszeiger im Arbeitsbereich befindet. 

- Durch verschieben der Maus kannst du den Würfel verschieben. (G steht für englisch „grab“.) 

- Wiederum schränken wir die Richtung ein: Drücke die Y-Taste. 

- Um den Würfel um genau 1 Längeneinheit in positiver Richtung zu verschieben, gib über die 

Tastatur eine 1 ein und bestätige mit RETURN. 
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2.7 
In der Mitte unten hat es drei wichtige Buttons die wie folgt aussehen: 

 

- Wenn der linke aktiv ist kannst du mit der rechten Maustaste Ecken selektieren. 

- Wenn der mittlere aktiv ist kannst du mit der rechten Maustaste Kanten selektieren. 

- Wenn der rechte aktiv ist kannst du mit der rechten Maustaste Flächen selektieren. 

Mach dich den drei Buttons vertraut indem du einige Kanten/Ecken/Flächen anwählst. 

2.8 
Drücken der SHIFT-Taste erlaubt dir z.B. mehrere Kanten auszuwählen. Alle ausgewählten Kanten 

werden orange gefärbt. Die zuletzt ausgewählte Kante wird weiss. Analog mit Flächen und Ecken. 

Denke daran dass du mit der A-Taste alles selektieren/deselektieren kannst. 

2.9 
Drehe die Ansicht mit der mittleren Maustaste, so dass du den Quader wie auf dem folgenden Bild 

betrachtest. Die Y-Achse (grün) sollte von dir wegzeigen. 

 

Dann wähle wie auf dem Bild nur die vordere Fläche an. 
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2.10 
Diese Fläche wollen wir löschen. Drücke dazu DELETE und wähle Faces. 

 

Der Quader ist nun auf einer Seite offen. 

Vergiss nicht, dein Projekt regelmässig zu speichern! 

2.11 
Drehe die Ansicht wieder, so dass du auf die geschlossene Seite schaust. Den Quader wollen wir nun 

horizontal in drei Scheiben schneiden. 

- Drücke CTRL+R um einen sogenannten Loop Cut durchzuführen 

 
- Durch drehen des Mausrades nach oben oder drücken der Taste + kann die Anzahl Schnitte 

erhöht werden. Wähle 2 Schnitte und bestätige mit einem Klick. 

 
- Wenn du jetzt dies Mausbewegst können die Schnitte verschoben werden. Positioniere die 

Maus so, dass drei etwa gleich hohe Scheiben entstehen und klick ein weiteres Mal um zu 

bestätigen. 
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2.12 
Zerschneide den Quader auch vertikal in drei gleich grosse Stücke. Wenn du beim letzten Schritt des 

Loop Cuts (also dann wenn du durch verschieben der Maus die Schnitte positionieren kannst) statt 

die linke Maustaste auf der Tastatur ESCAPE drückst, dann werden die Schnitt exakt so positioniert, 

dass alle Scheiben gleich dick sind. 

 

2.13 
Wähle mit der rechten Maustaste das mittlere der 9 Rechtecke aus. 

 

Dieses Rechteck wollen wir jetzt in y-Richtung (grüne Achse) ziehen so dass ein Flügel entsteht. 

- Drücke die Taste E (wie extrude) und bewege die Maus um zu beobachten was passiert. 

- Wir wollen die Fläche genau in y-Richtung herausziehen. Also drücke die Y-Taste. 

- Herausziehen um 4 Längeneinheiten scheint etwas passend. Drücke 4 und danach RETURN. 

 

2.14 
Um auf der anderen Seite auch einen Flügel zu modellieren verwenden wir den mirror modifier. 

Diese Funktion von Blender erlaubt es uns das Raumschiff auf der anderen Seite symmetrisch zu 

ergänzen. 
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- Klick rechts auf den Schraubenschlüssel und danach auf Add Modifier. 

 
- Wie du erkennst hat Blender einige Modifiers zu bieten. Wähle den Mirror aus. 

 
- Entferne den Haken bei X und setzte einen bei Y. Klick danach nicht auf Apply. 

 
- Das Raumschiff wird nun symmetrisch ergänzt. 

 
- Wir können die eine Seite des Raumschiffs modellieren während die zweite automatisch 

ergänzt wird. Der Mirror Modifierer wir also nicht nur einmalig angewendet sondern 

dauernd. Das ändert sich sobald auf Apply geklickt wird, was wir erst später in diesem 

Tutorial tun werden. 
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2.15 
Nun kümmern wir uns um den Rumpf des Raumschiffs. 

- Wähle unten den mittleren Button um Kanten zu selektieren und wähle die im Bild markierte 

Kante aus. 

 
- Schiebe mit der linke Maustaste den roten Pfeil zurück. Dies bewirkt eine Verschiebung der 

gewählten Kante in negative x-Richtung. Schiebe auch den blauen Pfeil leicht nach unten. Das 

Ergebnis sollt wie folgt aussehen. 

 

2.16 
Runde auch die Kanten vorne unten und hinten unten ab. Die Kante hinten oben habe ich 

stattdessen nach oben und hinten gezogen. Das Ergebnis könnte etwa so aussehen. 
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2.17 
Wähle wie abgebildet einen Kreis von Kanten aus.  

 

Zur Erinnerung: Mehrere Kanten können mit gedrückter SHIFT-Taste ausgewählt werden. 

2.18 
Diese Kanten möchten wir in negative y-Richtung etwas zurückschieben. Verschiebe dazu den grünen 

Pfeil gegen die Pfeilrichtung. 

 

2.19 
Das Modell ist nun fast fertig. Hier noch zwei kleine Tests: 

- Weisst du noch wie der Loop Cut funktioniert? Wenn nicht schau bei 2.11 nach. Zerschneide 

den Flügel wie hier abgebildet. 
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- Weisst du noch wie man Flächen auswählt? Wenn nicht schau bei 2.7 nach. Selektiere die 

äusserste Fläche des Flügels und ziehe sie mit dem blauen Pfeil nach oben. 

 
- Zieh dieselbe Fläche mit dem roten Pfeil gegen Pfeilrichtung weit nach hinten. 

 
- Die ausgewählte Fläche wollen wir nun um genau 30° um die x-Achse rotieren. Gib also R X 

30 über die Tastatur ein. 

- Auch um die z-Achse wollen wir die Fläche rotieren. Wir könnten selbstverständlich R Z 20 

eingeben. Die folgende Variante ist aber manchmal flexibler: Wähle in der unteren Leiste den 

Gebogen Pfeil aus. 

 
- Nun kannst du den blauen Bogen mit der Maus verschieben um eine Drehung der gewählten 

Fläche um die z-Achse zu bewirken. 

 
- Nachdem du die Fläche gedreht hast, wähle in der Leite wieder gen geraden Pfeil. 

 

2.20 
Jetzt ist es an der Zeit, denn Mirror Modifierer anzuwenden. Da es hierbei kein Zurück gibt, solltest 

du dein Modell kurz einem Assistenten zeigen und eine Sicherungskopie erstellen. 

Wende Modifier so spät wie möglich an. 
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- Wechsle durch drücken der TAB-Taste während der Mauszeiger im Arbeitsbereich ist wieder 

zurück in den Object Mode. 

 
- Klick im Modifier-Menu auf Apply 

 
- Drücke wieder die TAB-Taste um in den Edit Mode zu gelangen. 

2.21 
Wähle die 8 Kanten aus, die die beiden Flügel vom Rumpf trennen. 

 

2.22 
Drücke nachdem du die Kanten ausgewählt hast CTRL+E. Es öffnet sich das Menu Edges. Wähle die 

Option Mark Seam. 
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Die gewählten Kanten werden darauf rot. Dies wird später für die Texturierung wichtig sein. 

2.23 
Du denkst sicher, dass das Raumschiff noch sehr eckig ist. Die Polygon-Anzahl muss erhöht werden. 

Dazu gibt es den Subdivision Surface Modifier. 

- Drücke die TAB-Taste um in den Object Mode zu gelangen. 

- Klick auf den Schraubenschlüssel, dann auf Add Modifier und danach auf Subdivision Surface. 

 
- Wähle bei View und bei Render jeweils 3 und klick danach auf Apply. 

 
- Wechsle mit TAB wieder zurück in den Edit Mode. 

 

Arbeite vom Grossen zum Kleinen. D.h. modelliere zuerst die Grobstruktur deines Modells und füge 

danach die Details hinzu. Zusätzliche Polygone einfügen ist einfach (mit Loop cuts, Subdivision 

Surface modifier, ...). Viele Ecken und Kanten entfernen, verschieben oder Ähnliches wird aber zur 

mühsamen Kleinarbeit. 

2.24 
Das Raumschiff hat in Blender immer noch den Namen „cube“. 
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- Benenne es in „tutorialship“ um, indem du auf den alten Namen doppelklickst und den 

neuen eingibst. 

 
- Klick auf das Plus und gib auch im Untermenu „tutorialship“ als Name ein. 

 

2.25 
- Betrachte dein Schiff von hinten und zoome hinein. 

 
- Markiere einen durchgehenden Weg von Kanten zwischen den beiden Roten Kanten um die 

Flügel. Wie du schon weisst kannst du mit der SHIFT-Taste mehrere Kanten selektieren. 

Die CTRL-Taste funktioniert ähnlich wie die SHIFT-Taste beim wählen von Kanten. Probiere es aus. 

 
- Drücke wie bei 2.22 wieder CTRL+E und wähle Mark Seam. 
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2.26 
Nun sind wir fertig mit dem modellieren und es wird Zeit das Modell zu texturieren. 

- Dazu muss zuerst das Material-Menu geöffnet werden. 

 
- Als Namen für das Material wählen wir wieder „tutorialship“. Einfach den Materialnamen ins 

markierte Feld eingeben und mit RETURN bestätigen. 

 
- Öffne jetzt das Texture-Menu. 

 
- Gib als Name für die Textur wieder „tutorialship“ ein. 

 
- Wähle bei Type den Menupunkt Image or Movie 
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- Lade irgendeine PNG-Datei aus dem Internet herunter und benenne sie in tutorialship.png 

um. 

- Klick auf Open und wähle die Datei tutorialship.png aus 

 

Benenne Material, Modell, Textur und PNG-Datei immer gleich. Somit bleibt der Modell-Ordner in 

Orxonox übersichtlich. 

2.27 
Um das Raumschiff zu texturieren, muss die Oberfläche des Raumschiffs in die Ebene projiziert 

werden. Die zweidimensionale Oberfläche des Raumschiffs im dreidimensionalen Raum wird auf ein 

zweidimensionales PNG Bild abgebildet. 

- Wechsle in den UV Edititing Modus 

 
- Selektiere das ganze Schiff. 

- Drücke die Taste U und wähle die Option unwrap. 
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- Gib in der mittleren Toolbar bei der Option Margin den Wert 0.01 ein. Falls die Toolbar nicht 

sichtbar ist, drücke T während sich die Maus in der rechten Bildschirmhälfte befindet. 

 
- Klick auf das Symbol unten links und dann auf die Datei tutorialship.png 

 
- Du siehst, dass das Schiff entlang der rot markierten Kanten aufgeschnitten und danach in 

die Ebene projiziert wurde. Jedem Ecken deines Modells im Raum (X,Y,Z) ist jetzt ein Punkt in 

der Ebene (U,V) zugeordnet. 

 
- Unten in der Mitte der UV-Ansicht hat es vier Buttons, welche ähnlich funktionieren wie die 

drei Buttons in der 3D Ansicht um Ecken, Kanten und Flächen auszuwählen. Mit den ersten 

drei Buttons von links kannst du in der UV-Ansicht Ecken, Kanten und Flächen auswählen. 

Mit dem ganz rechten kannst du sogenannte Inseln auswählen. Dies sind 

zusammenhängende Gitter. Unser Raumschiff besteht aus drei Inseln. Mach dich mit den vier 

Buttons vertraut. 

 
- Beachte, dass zwischen zwei Inseln immer ein Mindestabstand befindet. Inseln berühren sich 

nie. Dies liegt daran, dass wir die Option Margin auf 0.1 setzten. Dieser Mindestabstand 

erleichtert das Erstellen von Texturen mit Photoshop oder GIMP erheblich. 

Betrachte das in die Ebene projizierte Modell (UV-Map). Du solltest erkennen, dass das Gitter nicht 

überall gleich dicht ist. Ein dichtes Gitter bedeutet, dass die Auflösung in deinem Modell dort 

schlechter ist. Ein lockeres Gitter hat eine bessere Auflösung zur Folge. Idealerweise ist die Auflösung 

überall etwa gleich. Die Wahl der Schnittkanten und die Art der Projektion beeinflusst diese Dichte. 

Um überall etwa die gleiche Dichte zu erzeugen kannst du die Funktion UVs → Minimize Stretch 

verwenden. 
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- Leider nützt Minimize Stretch oft nur wenig. Besser ist eine intelligentere Wahl der 

Schnittkanten. Überlege dir wie die Schnittkanten besser gewählt werden könnten. Wechsle 

wieder in den Default Modus und definiere dann in deinem Modell die Schnittkanten neu.  

Um alle Schnittkanten in deinem Modell zu entfernen, drücke zuerst die Taste A um das 

ganze Modell anzuwählen, dann CTRL+E um das Kanten-Menu zu öffnen. Klick dann auf Clear 

Seam um die Schnittkanten zu entfernen.  

 
- Wiederhole nun auch den Unwrap Pozess und wechsle in den UV Editing Modus um das neue 

UV-Layout zu betrachten. Sobald du mit dem Ergebnis zufrieden bist, zeige dein UV-Layout 

einem Assistenten bevor du mit dem Tutorial weiterfährst. 

- Wechsle wieder zurück in den Default Modus. 

 
- Damit die Textur im Modell rechts angezeigt wird musst du im Viewport Shading Menu den 

Punkt Texture wählen. 

 
- So sollte dein Raumschiff nun etwa aussehen: 

 
- Die verwendete Textur sieht wohl nicht zufriedenstellend aus. Wir sollten eine eigene Textur 

zeichnen. Dazu musst du jetzt das UV-Layout exportieren. Wechsle in den UV Editing Modus 

und dann UVs → Export UV Layout. Überschreibe dabei die Datei „tutorialship.png“. 

 
- Betrachte die exportierte Datei „tutorialship.png“ mit einem geeigneten Programm. Auf 

Basis dieser Datei könnte nun mit GIMP oder Photoshop eine eigene Textur gezeichnet 

werden. Dies soll aber nicht Bestandteil dieses Tutorials sein. Verändere die Datei mit einem 

Grafikprogramm ein wenig, speichere und schliesse das Programm wieder.  
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- Schalte in den Default Modus um und öffne das Textur-Menu 

 
- Lade dann mit einem Klick auf die Pfeile die Textur neu. 

 

Zu einem symmetrischen Objekt passt oft auch eine symmetrische Textur. Um dies zu erzwingen 

hätten wir mit dem Mirror Modifier auch eine Symmetrie entlang der u- oder v-Koordinate einfügen 

können. 

2.28 
Die Unterseite des Schiffs erscheint schwarz. Das liegt daran, dass es nur von der Oberseite 

beleuchtet wird.  

- Wechsle in den Object Mode (TAB-Taste). 

- Füge eine Lampe ein 

 
- Positioniere die Lampe durch ziehen an den Pfeilen so dass das Schiff auch von unten 

beleuchtet wird. 

- Anstatt eine zweite Lampe zu platzieren kannst du auch alle Lampen löschen. Dies bewirkt, 

dass dein Modell statisch von allen Seiten gleichmässig beleuchtet wird. 

2.29 
Überprüfen wir, aus wie vielen Dreiecken unser Raumschiff besteht. Dies kannst du ganz oben rechts 

ablesen: 

 

Über 8000 Dreiecken sind deutlich zu viele für ein Orxonox-Raumschiff! Auf der Orxonox-Website 

findest eine Guidline dazu, die du unbedingt einhalten solltest. Zu viele Dreiecke bewirken 

aufwändigere Berechnungen und verhindern somit, dass das Spiel flüssig läuft. 

Runde und sehr detaillierte Objekte benötigen viele Dreiecke, eckige Objekte brauchen weniger. 

Beachte auch, dass in einem Orxonox-Level Objekte eventuell mehrfach vorkommen können. Eine 
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Raumstation die in einem Level nur einmal vorkommt darf mehr Dreiecke verwenden als ein 

Raumschiff welches mehrmals instanziiert wird. 

Das Raumschiff ist nun fertig und bereit zum exportieren. Zeige dein Werk nochmals einem 

Assistenten bevor du mit diesem Tutorial weiterfährst. 

3.1 
- Wähle im Object-Mode mit der rechten Maustaste nur das Raumschiff aus. 

- Vergewissere dich, dass der Schwerpunkt des Raumschiffs im Ursprung des 

Koordinatensystems von Blender liegt. 

- Klick auf Object → Apply → Rotation & Scale 

 

Vor dem Exportieren muss immer Object → Apply → Rotation & Scale ausgeführt werden. Sonst wird 

das exportierte Modell verzerrt und verschoben. 

3.2 
Nun kommt der bei 1.5 installierte Exporter zum Einsatz. 

- Wähle im Object-Mode mit der rechten Maustaste nur das Raumschiff aus. 

- Klick auf File → Export → Ogre3D (.scene and .mesh) 
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- Entferne den Haken bei Export Scene. 

 
- Wähle als Dateinamen „tutorialship“ (Keine Dateiendung eingeben!) und klick auf Export 

Ogre. 

 
- Der Exportvorgang sollte drei Dateien erzeugt haben (tutorialship.material, tutorialship.mesh 

und tutorialship.mesh.xml). 

3.3 
Kopiere die neue gerade eben exportierte Datei tutorialship.mesh sowie die Dateien 

tutorialship.material und tutorialship.png gemäss folgender Tabelle in den Orxonox Ordner. 

Datei Zielpfad 

tutorialship.mesh data_extern/models 

tutorialship.material data_extern/materials 

tutorialship.png data_extern/images/textures 

3.4 
Um das von dir erstellte Raumschiff im Spiel zu betrachten, musst du zuerst ein Level schreiben, dass 

dein Modell verwendet. 

Öffne die Datei „data/levels/emptyLevel.oxw“ mit einem Texteditor. 

3.5 
Suche in der Datei die folgende Zeile: 

<SpawnPoint team=0 position="-200,0,0" lookat="0,0,0" spawnclass=SpaceShip pawndesign=spaceshipescort /> 

Gib direkt eine Zeile darunter folgendes ein: 

<Model position=“0,0,0“ mesh="tutorialship.mesh" scale="3" /> 
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3.6 
Starte Orxonox und wähle das Level emptyLevel. Du solltest dein Modell direkt vor dir erkennen. Falls 

das Spiel abstürzt oder Fehler ausgibt, wenden dich an einen Assistenten. Ansonsten herzliche 

Gratulation, dass du dieses Tutorial erfolgreich abgeschlossen hast und weiterhin viel Spass im 

Orxonox-PPS! 


